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Deven Ahlawat
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Prerequisites

This research would require the below mentioned pre-requisites to replicate it which
include some installations and credentials as listed below -

1.

2.

Setup a Kali Linux on AWS EC2 instance with minimum t2.medium specification.
Install Python3 v3.10 on Kali instance.

Install RDP on Kali operating system F:]

. Install Google Chrome browser on Kali Instance.

Install Java JDK on Kali Instance.
Email and Password for sending email via SMTP.

BurpSuite Professional Licence Key.

This research was conducted with the below system specifications and

2

1.

2.

Table 1: Preferred configuration for the host

Property Description Version
Platform AWS n/a
Instance Type Type T t2.medium
Operating System Kali 2022
Programming Language Python 3.10
RAM 4GB n/a
CPU 2vcore n/a
BurpSuite Professional 2022 n/a

Sign Up for Akeero Serverless

Create a free account on Akeero Serverless ] Fig /1]

Enter the required details to make an account.



Y AKEERO

Create your free
Akeero account

No credit card is required.

Enter your first name
Enter your surname
Enter your email

Enter your company name

Get started now

Figure 1: Akeero Serverless Sign Up Page

Thanks for signing up to Akeero! D inbox =S oI

) no-reply@akeero.com 5:43PM (Ominutesago) Yy €
. to devenahlawat+nci v

Y AKEERO

Hi Deven
We just need you to verify that you're a real human by clicking below.

It's not that we don't believe you, but there's a lot of bots out there!
| swear I'm not a bot!

Once this is done, we'll set up your unique Akeero domain and you can set
your password and get started!

Thanks
The Akeero Team

YAKEERO

Figure 2: Akeero Serverless Email confirmation

3. Check your email inbox for a sign up mail and click on "I swear I'm not a bot!” Fig

2l

Thttps: //www kali.org/docs/general-use /xfce-with-rdp/
https://www.akeero.com /sign-up




4. A confirmation page will be shown Fig |3| and a welcome email for setting the
password should arrive in your inbox Fig [4]

Success - you're not a robot!

We knew we could trust you! We'll send you another email shortly - there’s just a couple more steps and you'll be good to go with
Akeero, so please check your inbox!

o Join us on Slack!

Figure 3: Akeero Serverless Bot confirmation successful page

Welcome to Akeero D linboxx a @

@ no-reply@akeero.com 546PM@minutesago)  fr €
@ o devenahlawatenci ~

YAKEERO

Welcome to Akeero!

We're delighted you've decided to jump onboard our secure design platform.
We've set up your unique domain, and we just need you to set your password
by clicking the link below:

Set Password

Once your password is set, you'll have access to your very own Akeero
domain, where you can invite colleagues and start to collaborate.

Every domain within Akeero is unique, segregated and secured. This means
that each domain also has a unique url.

Your domain url is:

We recommend that you save this url as a bookmark in your browser for
quick and easy access to Akeero!

Your usemame is:

We hope you enjoy using our platform and we'll be in touch soon to get some
feedback!

Thanks
The Akeero Team

Y AKEERO

Figure 4: Akeero Serverless Email for setting password

5. Note the domain URL and login username and click on Set Password as shown in

Fig
6. Set a strong password with the mentioned requirements Fig [5]

7. After setting the password, open the Welcome Email again and click on the custom
akeero domain mentioned in the mail Fig

8. Login with your details in the login prompt Fig [6]



¥

Change Your Password

Enter a new password below to change your
password.

New password ©

Re-enter new password ©

Your password must contain:
At least 8 characters
At least 3 of the following:
Lower case letters (a-z)
Upper case letters (A-Z)
Numbers (0-9)

Special characters (e.g. |@#$%"&*)

Reset password

Figure 5: Akeero Serverless Password setup page

¥

Signin

Akeero app for Akeero Serverless

Email address
[ 3

Password ©

Forgot password?

| il

Figure 6: Akeero Serverless Login Page

9. Login page will lead to a page which will ask to set up mandatory multi-factor
authentication Fig[7]

10. Click on ”Trouble Scanning?” and copy the CODE shown from the next prompt



Secure Your Account
Scan the QR Code below using your preferred

authenticator app and then enter the provided
one-time code below.

Trouble Scanning?

THEN

Figure 7: Akeero Serverless Set 2FA prompt

{ Enter your one-time code

Fig [8]

\?

Secure Your Account

Manually enter the following code into your
preferred authenticator app and then enter the
provided one-time code below.

]
Z31

Copy code

{ Enter your one-time code

Figure 8: Akeero Serverless 2FA secret code




11. Open a new terminal, write python3 and press Enter. Write the below code line-
by-line
import pyotp
totp = pyotp. TOTP(” <Paste the copied secret CODE here>")
totp.now()

12. Enter the generated code into the Input field in Fig[§| and click Continue.
13. Save the backup code presented and click Continue.

14. Click Accept on the Authorize app prompt Fid [J] and the sign up is complete now.

\C

Authorize App

Hi Deven Ahlawat,

Akeero Serverless is requesting access to your
Akeero account.

e Profile: access to your profile and email

Figure 9: Akeero Serverless Authorize app prompt

Figure 10: Akeero Serverless

3 Burp Installation

BurpSuite Professional was used for this research. BurpSuite is vulnerability scanner that
is used to test web applications, this research made use of the Professional version which
has Passive Scanner functionality in it. Here are the steps to set it up

1. Download the BurpSuite Professional Jar file from Burp Downloads page )| as shown
in Fig

3https:/ /portswigger.net /burp/releases#professional



£1 PortSwigger

Products Vv | Solutions v | Research | Academy | Daily Swig | Support v | =

Burp Suite Releases
CCOMMUNITY) (ENTERPRISE) { Cl/CD DRIVER DASTARDLY

Professional /| Community 2022.12.5

Released Wednesday, 21 December 2022

[ Burp Suite Professional ¢} [ JAR :] & DOWNLOAD view checksums

This release contains a bug fix for Burp's diagnostics.

Usage of this software is subject to the licence agreement. read more v

AT

e » o

10.
11.
12.
13.

14.

Figure 11: BurpSuite Professional Download page

Save the JAR file to a location on your Kali instance.
Download the Jython Standalone JAR file from the Jython websitd’]
Save the JAR file to a location on your Kali instance.

Open BurpSuite Professional JAR file from the saved location using the command
"java -jar burpsuite_pro_v2022.12.5.jar”

Activate BurpSuite Professional by entering the Licence Key.

Select ” Temporary project” and Click Next Fig[12]

Select " Use Burp defaults” on the configuration page and click Continue Fig
Go to the "Extensions” tab and then to the ”Options” tab.

Click on the "Select file ...” button in the "Python Environment” section.
Browse to and select the Jython Standalone JAR file as shown in Fig
Browse to ”Installed” tab within Extensions tab and click on 7 Add”.

Select the "Python” option in the ”Extension type” dropdown menu and locate the
"burp_ext.py” file from Research Artifacts as shown in Fig[15]

Select the ”Save to file” option in the ”Standard Output” section and create a file
name ” Passive-Scan-Output.txt” in the downloaded Research Artifacts folder

4https://www.jython.org/downloads.html



4 Burp Suite Professional v2022.12.5 - licensed to trial user [2 user license]
@ Welcome to Burp Suite Professional. Use the options below to create or open a project. Bu rp SUIte

Professional

© Temporary project
New project on disk Name:
File: Choose file...
Open existing project Name File
testprojl.burp /home/deven-new/Desktop/burp_automation/testprojl.burp
File: Choose file...

Cancel m

Figure 12: BurpSuite Professional Start Page

4 Burp Suite Professional v2022.12.5 - licensed to trial user [2 user license]
-
@ Select the configuration that you would like to load for this project. Burp Su Ite

Professional
© Use Burp defaults

Use settings saved with project

Load from configuration file File

File: Choose file...

Default to the above in future

Disable extensions

Cancel Back Start Burp

Figure 13: BurpSuite Professional load configuration page

15. Click on "BApp Store” Tab within the Extensions tab and search for ”software”



4 Burp Suite Professional v2022.12.5 - Temporary Project - licensed to trial user [2 user license]

Burp Project Intruder Repeater Window Help
Dashboard Target Proxy Intruder Repeater Collaborator Sequencer Decoder Comparer Logger Extensions Learn {5} Settings
Installed BApp Store APIs Options
() Settings
@} These settings control how Burp handles extensions on startup.
Automatically reload extensions on startup

Automatically update installed BApps on startup

(3) JavaEnvironment
{§} These settings let you configure the environment for executing extensions that are written in Java. If your extensions use any libraries, you can specify a folder from which libraries will be loaded.

Folder for loading library JAR files (optional):
Select folder ...

(3) Python Environment
{:CE} These settings let you configure the environment for executing extensions that are written in Python. To use Python extensions, you will need to download Jython, which is a Python interpreter implemented in Java.

Location of Jython standalone JAR file:
'home/deven-new/Desktop/burp_automation/jython-standalone-2.7.3 jar Select file ...

Folder for loading modules (optional):

Select folder ...

(3) Ruby Environment

{§} These settings let you configure the environment for executing extensions that are written in Ruby. To use Ruby extensions, you will need to download JRuby, which is a Ruby interpreter implemented in Java. Note
that you can either configure the location of the JRuby JAR file here, or you can load the JAR file on startup via the Java classpath.

Location of JRuby JAR file:
Select file ...

Figure 14: Load Jython standalone in BurpSuite Professional

16. Select Software Version Reporter and Click Install as shown in Fig
17. Select Software Vulnerability Scanner and Click Install as shown in Fig

18. Click on the Proxy Tab

19. Select Options Tab within Proxy and check if Proxy is running on interface ”127.0.0.1:8080”

as shown in Fig

20. Select "Burp>User Settings>Save user settings” and save it to a file as shown in

Fig

21. Select ”Project>Project Settings>Save project settings” and save it to a file as
shown in Fig

22. Close BurpSuite Professional

BurpSuite Professional is now installed and fully configured with necessary settings
and extensions. Please close the burp suite window before proceeding to the next step.

4 Install Dependencies

Install Python dependencies using the following commands

pip3 install selenium
pip3 install pyotp
pip3 install smtplib
pip3 install datetime



Burp Project

‘ Dashboard Target Proxy Intruder Repeater Collaborator Sequencer Decoder Comparer
Installed BApp Store APIs Options

Intruder Repeater Window Help

A Total estimated system impact:  Low @D

Burp Extensfie Load Burp Extension

Extensions let
Add
Remove
Up

Down

Details

Extensiol

Name: | Pasj

Extension tyf
Filename
Method

Audit issue I

Please enter the details of the extension, and how you would like to handle standard output and error.

Extension Details

Extension type: Python v
Extension file (.py): = 'w/Desktop/burp_automation/burp_ext.py Select file ...

Standard Output

Output to system console
© savetofile:  urp_automation/Passive-Scan-Output.txt Select file ...
Show in Ul

Standard Error

Output to system console
Save tofile: Select file ...

© showinul

Logger Extension

Cancel

Figure 15: Load custom extension in BurpSuite Professional

pip3 install email
pip3 install csv

It is assumed that the artifacts have been downloaded and extracted into a folder.
File Structure overview is listed below -

1. main.py - Core file which performs all the operation, appropriate comments are
present to explain each block of code.

Edit Line 26 with <burp jar file location>, <project file location>, <project

config file location>and <user config file location>

Edit Line 23 with <burp project file location>and <Report output file in

artifacts folder>
Edit Line 42 with your MFA code.

Edit Line 47,62,82,92 and 109 with your custom Akeero domain without chan-

ging the rest of the URL.

Edit Line 119 with akeero-test-di.json file fome artifacts with absolute path

location.

Edit Line 216 to configure recipient email address to receive the report.

10



Burp Suite Professional v2UZZ.12.5 - | emporary Project - licensed to trial user |2 user license]

Burp Project Intruder Repeater Window Help

Dashboard Target Proxy Intruder Repeater Collaborator Sequencer Decoder Comparer Logger Extensions Learn {5} Settings
Installed BApp Store APIs Options

A\ Total estimated system impact: Low @H®

BApp Store ®
The BApp Store contains Burp extensions that have been written by users of Burp Suite, to extend Burp's capabilities. O [ software
Name Installed Rating Popularity Last updated System impa... Detail Soft vl bility s

. . oftware Vulnerability Scanner
Software Version Reporter 22 Apr 2021 Low Pro extension Y
Software Vulnerability Scanner 1 09Apr2019  Low Pro extension This ion scans for vulnerabilities in detected software versions using the
BugPoC 22Jun2020 Low Vi " API
Code Dx 06Jun2018  Low Pro extension :
CSTC, Modular HTTP Manipulator 10Jul2020  Low It has two main features:
HeartBleed 1 01Jul2014  Low

B « Detect vulnerable software by fingerprints or CPE
: —i 26 Feb2020 Low Pro extension
21Feb2022 Low « Detect possible vulnerable paths which appeared in any exploits

| 25Jan2017  Low Pro extension

Image Location and Privacy Scanner
LightBulb WAF Auditing Framework
ThreadFix

4
7
4

Estimated system impact ®
Overall: Low <~

Memory CPU Time Scanner
& Low © Low © Low B Low

Author:  Vulners.com

Version: 12

Source: https://github.com/portswigger/software-vulnerability-scanner
Updated: 09 Apr2019

Rating: Y7 Yr7r Ty
Popularity: 4'

Figure 16: Install BurpPro extensions

Burp Project Intruder Repeater Window Help

Dashboard Target Proxy Intruder Repeater Collaborator Sequencer Decoder Comparer Logger Extensions Learn Versions {5} Settings
Software Vulnerability Scanner

Intercept HTTP history WebSockets history Options
(3) Proxy Listeners

@ Burp Proxy uses listeners to receive incoming HTTP requests from your browser. You will need to configure your browser to use one of the listeners as its proxy server.

Add Running Interface Invisible Redirect Certificate TLS Protocols
Edit 127.0.0.1:8080 Per-host Default
Remove

Each installation of Burp generates its own CA certificate that Proxy listeners can use when negotiating TLS connections. You can import or export this certificate for use in other tools or another installation of
Burp.

Import / export CA certificate Regenerate CA certificate

Figure 17: BurpSuite Proxy settings

2. config.py - Contains configuration used in the main but must be protected. Please
replace username and password with your Akeero Login credentials as well as
SMTP_USERNAME and SMTP_PASSWORD. Check the SMTP_SERVER and
SMTP_PORT, please make the necessary changes as per your environment and
system.

3. burp_ext.py - Custom Jython based burp suite extension which is used to log issues
logged by burp scanner and output it to a file.

4. payloads.txt - Text file containg all the payloads that are to executed in different
inpput fields present in the app.

11



4 Burp Suite Professional v2022.12.5 - Temporary Project

Burp Project Intruder Repeater Window Help
Search Proxy Intruder Repeater Collaborator Sequencer

Settings nner

Configuration library ¥ WebSockets history Options

User settings > Restore defaults
Burp Infiltrator Load user settings _

Burp Clickbandit Save user settings TP requests from your browser. You will need to configure yot
Exit Ning Interface Invisible Redirect Certifica
Edit 127.0.0.1:8080 Per-host

Remove

Figure 18: Save BurpSuite User settings

Burp Suite Professional v2022.12.5 - Temporary Project - licensed to

Burp Project Intruder Repeater Window Help

Das Project settings > Restore defaults > [laborator Sequencer Decoder
Softy Rename Load project settings
Inter Save copy Save project settings

| ‘
@ Import legacy state file
@ burprroxy uses usceners woreceve mcormmyg AT TP requests from your browser. You will need to configure your browser

Figure 19: Save BurpSuite Project settings

5. akeero-test-di.json - Template file to create projects in the Akeero serverless applic-
ation.

6. burp-files - Directory that contains all the config files used during the research and
were required by burp to load with the desired extensions and configurations. These
files shall be replaced with the saved user and project configuration files in the above
section [3

5 Running the Code

Before running the code please ensure that all artifacts are downloaded and all the ne-
cessary changes are made as highlighted in the above section [4| and all the dependencies
are installed. To run the code

1. Open a new terminal
2. Browse to the updated artifacts folder with main.py file in it.
3. Enter command <python3 main.py>.

4. Press Enter

12



5. Check Terminal for console logs

6. Check Email for Testing Report.

13



Appendix H — Monthly Internship Activity Report

The Internship Activity Report is a 1-page monthly summary of the activities performed by you and
what you have learned during that month. The Internship Activity Report must be signed off by your
Company and included in the configuration manual as part of the portfolio submission.

Student Name: Deven Ahlawat Student number: x20214341

Company: Akeero Technologies Limited Month Commencing: October 2022

This month was spent on performing the Literature review on the WebSocket, serverless
implementation and automation of security test cases on application based on these
technology.

This was followed by identifying methodology to be employed for this research. Multiple
models were analyzed before finalizing Waterfall model which was very in-line given the
time-frame of research and steps.

Employer comments

Student Signature: Deven Ahlawat Date: 4 Jan 2023

Industry Supervisor Signature: Anthi Gilligan Date: 4 Jan 2023

MSc Internship Handbook, School of Computing, National College of Ireland.




Appendix H — Monthly Internship Activity Report

The Internship Activity Report is a 1-page monthly summary of the activities performed by you and
what you have learned during that month. The Internship Activity Report must be signed off by your
Company and included in the configuration manual as part of the portfolio submission.

Student Name: Deven Ahlawat Student number: x20214341

Company: Akeero Technologies Limited = Month Commencing: November 2022

Manual Penetration testing of the Akkero Serverless application was carried out in this
month with the help of BurpSuite Professional and Kali linux installed on AWS EC2
instance.

This was followed by exploring multiple automation frameworks to automate the
testcases from the Manual penetration testing. Selenium was chosen because of its vast
resources available online along with its cross-browser implementation and greater
flexibility with to choose element with multiple identifiers using Python.

Employer comments

Student Signature: Deven Ahlawat Date: 4 Jan 2023

Industry Supervisor Signature: Anthi Gilligan Date: 4 Jan 2023

MSc Internship Handbook, School of Computing, National College of Ireland.




Appendix H — Monthly Internship Activity Report

The Internship Activity Report is a 1-page monthly summary of the activities performed by you and
what you have learned during that month. The Internship Activity Report must be signed off by your
Company and included in the configuration manual as part of the portfolio submission.

Student Name: Deven Ahlawat Student number: x20214341

Company: Akeero Technologies Limited Month Commencing: December 2022

Automation of test-cases was done in this month using Selenium and BurpSuite
Professional. This was followed by writing the burp extension to generate report and
deliver it to the respective stakeholders.

Employer comments

Student Signature: Deven Ahlawat Date: 4 Jan 2023

Industry Supervisor Signature: Anthi Gilligan Date: 4 Jan 2023

MSc Internship Handbook, School of Computing, National College of Ireland.
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